
Preside Multiservice Data Manager

MDMWeb
Installation Guide
241-6001-117





Preside Multiservice Data Manager

MDMWeb
Installation Guide
Publication: 241-6001-117
Document status: Standard
Document version: 14.3RSUP
Document date: December 2003
Copyright © 2003 Nortel Networks.
All Rights Reserved.

Printed in Canada

NORTEL, NORTEL NETWORKS, the globemark design, the NORTEL NETWORKS corporate logo, PRESIDE, 
DPN,and PASSPORT are trademarks of Nortel Networks. SUN, SOLARIS, and JAVA are trademarks of Sun 
Microsystems, Inc. NETSCAPE and NETSCAPE NAVIGATOR are trademarks of Netscape Communications 
Corporation. UNIX is a trademark licensed exclusively through X/Open Company Ltd. WINDOWS 2000, 
WINDOWS NT, WINDOWS XP and MICROSOFT are trademarks of Microsoft Corporation.





5

Publication history

December 2003
14.3RSUP Standard
Commercial availability.
Preside MDM MDMWeb Installation Guide   14.3RSUP



6   Publication history
241-6001-117   14.3RSUP   



7

Contents

About this document 11
Who should read this document and why 11
What you need to know 11
How this document is organized 12
What’s new in this document 12
Text conventions 12
Mouse button functions 14
Related documents 14

Chapter 1
Introduction 15
What is MDMWeb? 15
MDMWeb architecture 15
Partitioning 18
Choosing an MDMWeb client installation option 19

About client applications 19
Available options 19

Software requirements 22
Server software requirements 22
Client application 23

Installation overview 24
Server installation overview 25
Client application 25
MDMWeb migration 26

MDMWeb license key 26
Preside MDM MDMWeb Installation Guide   14.3RSUP



8   Contents
Chapter 2
Installing the MDMWeb server 27
MDMWeb server installation procedures 27

Preparing to install MDMWeb server software 28
Partitioning the network 28
Configuring the MDMWeb server 30
Changing the MDMWeb password 31

Starting the MDMWeb server agents 31
Displaying online server agent information 32
Starting the MDMWeb gmdragent 32
Starting the MDMWeb nmagent 33
Starting the MDMWeb rtacagent 34
Starting the MDMWeb mnsdagent 34

Server port numbers 35
Changing Apache port numbers 35

Chapter 3
Installing the MDMWeb client on Solaris 37
Solaris client application installation procedures 37

Preparing to install MDMWeb Solaris client 38
Installing Solaris patches for use with JRE 38
Installing JRE for Solaris 38
Installing MDMWeb Solaris client application 40
Configuring the resource file for MDMWeb Solaris client 41
Configuring the resource file for sound 42
Configuring the resource file to specify the mnsdagent port 43
Configuring the resource file to obtain alarms from RTAC 45
Configuring the resource file to use a custom menu 46
Configuring the resource file to edit CIV commands 47
Adding the server host name to the /etc/hosts file 49
Specifying the installed Netscape path 50

Removing the MDMWeb Solaris client application 51
241-6001-117   14.3RSUP   



Contents   9
Chapter 4
Installing the MDMWeb client on Windows 53
Windows client application installation procedures 53

Preparing to install MDMWeb client application software 53
Installing JRE for Windows 54
Installing the MDMWeb Windows client application 54
Configuring the resource file for MDMWeb Windows client 55
Configuring the resource file for sound 56
Configuring the resource file to obtain alarms from RTAC 57
Configuring the resource file to use a custom menu 58
Configuring the resource file to edit CIV commands 60

Removing the MDMWeb Windows client application 62

Appendix A  
Engineering Information 65
Resource requirements 65
Communication requirements 66
MDMWeb performance 66

Index 67
Preside MDM MDMWeb Installation Guide   14.3RSUP



10   Contents
241-6001-117   14.3RSUP   



11
About this document

This document describes how to install and configure Nortel Networks 
Preside Multiservice Data Manager MDMWeb software.

The following topics are discussed in this section:

• “Who should read this document and why” (page 11)

• “What you need to know” (page 11)

• “How this document is organized” (page 12)

• “What’s new in this document” (page 12)

• “Text conventions” (page 12)

• “Mouse button functions” (page 14)

• “Related documents” (page 14)

Who should read this document and why
This guide is intended for those who install and use the Nortel Networks 
MDMWeb software application. This guide contains detailed installation 
instructions for MDMWeb software.

What you need to know
This document assumes knowledge in the following areas:

• Preside Multiservice Data Manager (MDM) package

• MDM system administration

• Sun Solaris operating system
Preside MDM MDMWeb Installation Guide   14.3RSUP



12   About this document
• the MDMWeb client operating system, for example Windows 2000 or 
Windows NT

• Java scripts and applications

How this document is organized
The information in this guide is organized as follows: 

• “Introduction” (page 15) provides an overview of MDMWeb software 
and its capabilities.

• “Installing the MDMWeb server” (page 27) details MDMWeb server 
software installation and configuration procedures.

• “Installing the MDMWeb client on Solaris” (page 37) details MDMWeb 
Solaris client installation procedures.

• “Installing the MDMWeb client on Windows” (page 53) details 
MDMWeb Windows client installation procedures.

• “Engineering Information” (page 65) details MDMWeb resource and 
communication requirements.

What’s new in this document
The following feature was added to this document:.

• “MDM Shelf View Enhancements” (page 12)

MDM Shelf View Enhancements
All references to ccagent in this document have been replaced with psvagent. 
Psvagent has changed to a full-time server and incorporates ccagent 
functionality.

Text conventions
This document uses the following text conventions: 

• nonproportional spaced plain type

Nonproportional spaced plain type represents system generated text or 
text that appears on your screen.
241-6001-117   14.3RSUP   
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• nonproportional spaced bold type

Nonproportional spaced bold type represents words that you should type 
or that you should select on the screen.

• italics

Statements that appear in italics in a procedure explain the results of a 
particular step and appear immediately following the step.

Words that appear in italics in text are for naming.

• [optional_parameter]

Words in square brackets represent optional parameters. The command 
can be entered with or without the words in the square brackets.

• <general_term>

Words in angle brackets represent variables which are to be replaced with 
specific values.

• UPPERCASE, lowercase

In Preside Multiservice Data Manager (MDM), uppercase and lowercase 
letters that appear in UNIX commands and parameters must be matched 
exactly. The system matches upper and lowercase characters differently.

• |

This symbol separates items from which you may select one; for 
example, ON|OFF indicates that you may specify ON or OFF. If you do 
not make a choice, a default ON is assumed.

• ...

Three dots in a command indicate that the parameter may be repeated 
more than once in succession.
Preside MDM MDMWeb Installation Guide   14.3RSUP
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The term absolute pathname refers to the full specification of a path starting 
from the root directory. Absolute pathnames always begin with the slash ( / )
symbol. A relative pathname takes the current directory as its starting point, 
and starts with any alphanumeric character (other than /).

Mouse button functions
This documentation assumes default mouse button settings. The default 
functionality and relative position of these buttons are as follows:

• select, or left, mouse button
Use this button for such tasks as selecting items that will be subject to 
further action.

• modify, or middle, mouse button
Use this button for such tasks as drag and drop operations.

• menu, or right, mouse button
Use this button for such tasks as opening pop-up menus.

Related documents
See the following documents for related information:

• 241-6001-011 Preside MDM Fault Management User Guide

• 241-6001-030 Preside MDMWeb User Guide

• 241-6001-100 Preside MDM Installer Guide
241-6001-117   14.3RSUP   
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Chapter 1
Introduction

This section provides an overview of the MDMWeb software installation and 
includes the following topics:

• “What is MDMWeb?” (page 15)

• “MDMWeb architecture” (page 15)

• “Partitioning” (page 18)

• “Choosing an MDMWeb client installation option” (page 19)

• “Software requirements” (page 22)

• “Installation overview” (page 24)

• “MDMWeb license key” (page 26)

What is MDMWeb?
MDMWeb provides fault management capabilities similar to MDM Fault, but 
uses a common desktop environment. This software application operates as a 
stand-alone application.

MDMWeb architecture
The MDMWeb application uses a client/server architecture. The server runs 
on a Solaris platform and functions as an intermediary between an MDMWeb 
client and the Preside Multiservice Data Manager (MDM). The MDMWeb 
client runs on multiple platforms that include Solaris, Windows 2000, 
Windows NT, and Windows XP, and functions as the network management 
user interface.
Preside MDM MDMWeb Installation Guide   14.3RSUP



16   Chapter 1 Introduction
Within the MDMWeb application are a set of client and server agents built on 
top of the existing MDM fault management server architecture. MDMWeb 
clients open sessions with MDMWeb server agents. These server agents, in 
turn, connect to their corresponding MDM servers. The server agents are as 
follows:

• general management data router agent (gmdragent)
The gmdragent collects alarm information, alarm counts, and status 
counts from the MDM general management data router (GMDR). If 
MDMWeb is set up to use partitioning, gmdragent collects alarm 
information from the Network Access Data Mediator (NDAM) rather 
than from GMDR. The real time alarm collection (rtagent) also collects 
alarm history information if configured to do so.

• network model agent (nmagent)
The nmagent collects component and state information from the MDM 
Network Model (NM) Server. If MDMWeb is set up to use partitioning, 
nmagent collects state information from NDAM rather than from 
GMDR.

• passport shelf view agent (psvagent)
The psvagent authenticates users with groups and sends commands to 
those groups. Partitioning does not impact the psvagent.

• real time alarm collection (rtacagent)
The rtacagent gathers archived alarm information from RTAC. You can 
choose between using GMDR’s alarms or RTAC’s alarms. The default 
uses GMDR’s alarms.

• multi-nodal name server (mnsdagent)
The mnsdagent lets MDMWeb agents connect to any available port, 
instead of a fixed port. Mnsdagent is the only agent with a fixed port. The 
mnsdagent contains an interface on top of the Multi-nodal Name server 
(MNSD) that MDM Java applications use. For more information on 
mnsdagent, see 241-6001-310 Preside MDM Server Reference Guide.

The figure “Information flow between MDMWeb clients and MDM servers” 
(page 17) illustrates the flow of information among the MDMWeb clients, 
MDMWeb server agents, and MDM servers.
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Figure 1
Information flow between MDMWeb clients and MDM servers
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Partitioning
MDMWeb provides an optional feature that lets you partition the network. 
Partitioning a network makes access to specific network segments available 
to specific users. Consequently, users can focus on specific network segments 
rather than the entire network. For example, partitioning a large network by 
region lets users readily view management information for their specific 
region. 

MDMWeb does not require a separate workstation for every partition. A 
single MDM workstation manages partitioning.

When MDMWeb is set up with partitioning, the gmdragent and nmagent 
collect their management data from the Network Data Access Mediator 
(NDAM) rather than the General Management Data Router (GMDR) and the 
Network Model (NM) Server. Partitioning does not apply to the command 
console tool. Consequently, partitioning does not impact the psvagent. With 
careful planning of groups, however, the command console can mimic 
partitioning.

The following MDMWeb applications limit their data to the devices within 
their current partition:

• alarm display

• network browser

• component information viewer

The network status application does not limit its data. This application always 
displays counts for the entire network. If the alarm display is in alarm history 
mode and the RTACHISTORY option is enabled, then the data is also limited. 
The alarm display application always displays the alarm history of the entire 
network. 

Before partitioning a network, plan what the partitions will be and which user 
IDs to assign to these partitions. After you complete the planning, create an 
NDAM device filter file for each partition. Next, associate MDMWeb user 
IDs with the partitions. 
241-6001-117   14.3RSUP   
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Partitioning is achieved through the use of NDAM device filter files. For 
example, if you partition by the geographic areas north, east, south, and west, 
you need four NDAM device filter files. Each filter file specifies the devices 
for the partition. You can specify the contents of the filter file in two ways. 
You can list the devices to include in the partition or you can combine 
partitions by listing the names of other existing device filter files. 

The speed of filtering is a function of the number of lines in the partition filter 
file. The NDAM server slows as the number of lines in the filter file increases. 
When the network has consistent naming schemes for network nodes so that 
you can use wildcards, filter files are more efficient. For example, if you 
partition by geographic area and the nodes in the east consist of EM/EAST_1, 
EM/EAST_2, and EM/EAST_3, the contents of the device set filter file for 
the east need only contain the single entry
EM EAST*. 

For details about implementing partitioning, see “Partitioning the network” 
(page 28).

Choosing an MDMWeb client installation option
The MDMWeb package consists of server and client software. You must 
install the MDMWeb server software on a Solaris workstation. However, you 
have a choice of platforms for the MDMWeb client software. The MDMWeb 
client runs on Solaris, Windows 2000, Windows NT, and Windows XP 
platforms.

About client applications 
The MDMWeb client application is a standalone, Java-based application. 

Available options
Since the MDMWeb client supports multiple platforms and deployment 
options, you can choose from the following list of client installation options: 

• Solaris client application

• Windows 2000 client application

• Windows NT client application

• Windows XP client application
Preside MDM MDMWeb Installation Guide   14.3RSUP



20   Chapter 1 Introduction
For an overview of available installation options, see the figure “MDMWeb 
supported platforms, deployment options and software requirements” 
(page 21).
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Figure 2
MDMWeb supported platforms, deployment options and software requirements
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Software requirements
For MDMWeb, you need to install software packages on both the server and 
the client. The required packages include both Nortel Networks software and 
the following third-party products:

• Java Runtime Environment (JRE) 

• Solaris patches, and Windows service pack for JRE 

• Tomcat Web server

• MDMHelp

See the Preside Multiservice Data Manager (MDM) Release Supplement for 
details about the supported software versions required for MDMWeb. 

Server software requirements
For details about MDMWeb server software requirements, see the table 
“MDMWeb server software requirements and their availability from the 
MDM CD-ROM” (page 22).

Table 1
MDMWeb server software requirements and their availability from the MDM CD-ROM

Software requirements MDM CD-ROM

Available on 
CD-ROM?

Package ID Package Name or
File Name

Solaris No

MDM Yes

Solaris patches for JRE Yes Aux

 (Sheet 1 of 2)
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Client application
For details about MDMWeb client application software requirements, see the 
table “MDMWeb client application software requirements and their 
availability from the MDM CD-ROM” (page 23).

JRE for Solaris Yes MagJ<JRE version> for 
example, MagJ140

Sun Java Runtime 
Environment - <JRE version> 
for example, Sun Java 
Runtime Environment - 1.4.0, 
Standard Edition.

Note:  The Java Plug-in is 
included with the 
MagJ<release> package.

MDMHelp Yes MDMHELP MDMHelp Document 
Browser

Table 2
MDMWeb client application software requirements and their availability from the MDM 
CD-ROM

Software requirements MDM CD-ROM

Available on 
CD-ROM?

Package ID Package Name or
File Name

For Solaris only, system 
software patches

Yes AUX <Solaris version>/
<patchid>.tar

 (Sheet 1 of 2)

Table 1 (continued)
MDMWeb server software requirements and their availability from the MDM CD-ROM

Software requirements MDM CD-ROM

Available on 
CD-ROM?

Package ID Package Name or
File Name

 (Sheet 2 of 2)
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Installation overview
You need to install some of the required software on the Preside Multiservice 
Data Manager (MDM) workstation and some on an MDMWeb client. For 
details, see the following:

• “Server installation overview” (page 25)

• “Client application” (page 23)

• “MDMWeb migration” (page 26)

One of the following JRE 
versions that is 
appropriate for your 
installation:

Solaris Yes MagJ<JRE version> 
for example, 
MagJ140

Sun Java Runtime 
Environment 1.4.0, Standard 
Edition

Windows Yes AUX j2re<JRE version label>, for 
example, j2re 1_4_0_01-
windows-i586.exe

One of the following 
MDMWeb client 
applications that is 
appropriate for your 
installation

Solaris Yes MDMWeb_Install_
Solaris.bin

Windows Yes MDMWeb_Install_
Windows.exe

Table 2 (continued)
MDMWeb client application software requirements and their availability from the MDM 
CD-ROM

Software requirements MDM CD-ROM

Available on 
CD-ROM?

Package ID Package Name or
File Name

 (Sheet 2 of 2)
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Server installation overview
The following is an overview of the server installation tasks:

1 Install and configure Solaris software. For details, see 241-6001-100 
Preside MDM Installer Guide.

2 Load Preside MDM with the InstallAnywhere program and configure 
Preside MDM. For details, see 241-6001-100 Preside MDM Installer 
Guide. 

Note: When you follow the instructions contained in 241-6001-100 
Preside MDM Installer Guide, you manually install the Solaris patches 
for the Java Runtime Environment (JRE) required for MDM Web, then 
you use the InstallAnywhere program to load Preside MDM software. 
The InstallAnywhere program automatically loads all of the software 
required for the Preside MDMWeb server. This software includes: the 
JRE for Solaris, the Tomcat web server, MDMHelp, and MDM Web 
server software.

3 Configure the MDMWeb server.

4 Start the MDMWeb server agents.

5 If required, change ports for multiple versions of Tomcat.

For details, see “Installing the MDMWeb server” (page 27).

Client application
The following is an overview of the client application installation tasks:

1 Install the JRE software.

2 Install and configure the MDMWeb client application software on a 
Solaris, Windows 2000, Windows NT, or Windows XP platform. 

Note: The script sendwebcmd lets you use the invisible desktop, which 
provides a socket that listens to incoming commands and executes them 
as though they had been executed from the desktop. The script is 
packaged with the Solaris client application, and it is automatically 
installed.

3 Configure the MDMWeb client.
Preside MDM MDMWeb Installation Guide   14.3RSUP
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For details, see the section that is applicable to your system software:

• “Solaris client application installation procedures” (page 37)

• “Windows client application installation procedures” (page 53)

MDMWeb migration
If you are migrating from a previous version of MDMWeb, you must 
complete the following tasks:

• Install the new version of MDMWeb software.

• Start or restart the MDMWeb agents.

MDMWeb license key
Before you can run MDMWeb for the first time, you must have a license key. 
Nortel Networks provides this information along with the MDM software on 
the CD-ROM. If, for any reason, you do not have this information, contact 
your Nortel Networks account representative.
241-6001-117   14.3RSUP   
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Chapter 2
Installing the MDMWeb server

This section provides detailed procedures for installing and configuring the 
MDMWeb server software.

• “MDMWeb server installation procedures” (page 27)

• “Starting the MDMWeb server agents” (page 31)

• “Server port numbers” (page 35)

MDMWeb requires

• MDMWeb server software on a Preside Multiservice Data Manager 
(MDM) network management workstation as described in this chapter.

• a client desktop as described in one of the following sections:

— “Installing the MDMWeb client on Solaris” (page 37)

— “Installing the MDMWeb client on Windows” (page 53)

MDMWeb server installation procedures
For MDMWeb, you need to install both Nortel Networks and third-party 
software from the Preside Multiservice Data Manager (MDM) CD-ROM. 
Because there are software interdependencies, you must complete the 
procedures in the following order:

1 “MDMWeb migration” (page 26) (if needed)

2 “Preparing to install MDMWeb server software” (page 28)

3 “Partitioning the network” (page 28)

4 “Configuring the MDMWeb server” (page 30)
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5 “Displaying online server agent information” (page 32) (if required)

6 “Starting the MDMWeb gmdragent” (page 32)

7 “Starting the MDMWeb nmagent” (page 33)

8 “Starting the MDMWeb rtacagent” (page 34)

9 “Starting the MDMWeb mnsdagent” (page 34)

10 “Changing Apache port numbers” (page 35) (if required)

Preparing to install MDMWeb server software
Before you install the MDMWeb server software, ensure that you have a Sun 
workstation to install the MDMWeb server software on. Do the following on 
the workstation that you are going to use as the MDMWeb server:

1 Install and configure Solaris software. For details, see 241-6001-100 
Preside MDM Installer Guide.

2 Load Preside MDM with the InstallAnywhere program and configure 
Preside MDM. For details, see 241-6001-100 Preside MDM Installer 
Guide. 

Note:  When you follow the instructions contained in 241-6001-100 
Preside MDM Installer Guide, you manually install the Solaris patches for 
the Java Runtime Environment (JRE) required for MDMWeb, then you use 
the InstallAnywhere program to load Preside MDM software. The 
InstallAnywhere program automatically loads all of the software required 
for the Preside MDMWeb server. This software includes: the JRE for 
Solaris, the Apache web server, MDMHelp, and MDMWeb server 
software.

3 Verify that the MDM servers and applications are operational. If you are 
going to use partitioning, ensure that you verify that NDAM is also 
operational.

4 If required, set up partitions for the network. For details, see “Partitioning 
the network” (page 28).

Partitioning the network
Partitioning the network is optional. For an overview of partitioning, see 
“Partitioning” (page 18). If you use partitioning, verify that the NDAM server 
is set up and running. For details about setting up and starting NDAM, see 
241-6001-310 Preside MDM Server Reference Guide.
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Preparing for partitioning
1 Determine the partitions to use. For example, you might want to partition 

by city or by region.

2 Name each partition.

3 Determine the devices to include in each partition. 

Partitioning 
You can create partition files by defining the devices to include in the 
partition. If required, you can also create new partition files by combining 
existing partition files.

1 Using an editor such as vi, create an NDAM device filter for every partition 
using the name /opt/MagellanNMS/cfg/NDAM_<partition name>.dev 

For example, if you partition the network by the geographic areas north, 
east, south, and west, you need four device filter files. The partition 
names might be as follows:

NDAM_NORTH.dev
NDAM_EAST.dev
NDAM_SOUTH.dev
NDAM_WEST.dev

2 Add the following information to each device filter file: 

• a list of network model organization nodes (that is, any regions and 
any site) that precede the partition in the network hierarchy
For example, if a node for country precedes the geographic area 
partition examples shown in the previous step, include the country 
node in the file.

• the command Default* 
This command ensures devices under the nodes Default_Region 
and Default_Site are visible in the network browser

• a list of devices to include in the partition
Use wiildcards wherever possible for greater efficiency.

3 If needed, you can also create new partitions by combining existing 
device filter files. For example, to create a new partition for the northeast 
region, include the existing filter file names for the north and east:
#include NDAM_EAST.dev
#include NDAM_NORTH.dev
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4 Using an editor such as vi, edit the MDMWeb server configuration file 
/opt/MagellanNMS/cfg/private/MDMWebUsers.cfg. For every MDMWeb 
user, add a line using the following format:

<user ID>:<password>:[<partition name>]

5 Restart the NDAM server.

6 Restart the gmdragent server.

7 Restart the MDMWeb servers.

Variable definitions

Configuring the MDMWeb server
1 Using an editor such as vi, open the file

/opt/MagellanNMS/cfg/private/MDMWebUsers.cfg. 

2 Add the user ID names and passwords to the file:

<userid>:<password>

3 Save the changes and close the file.

Note:  For more information on passwords, see 241-6001-040 Preside 
MDM Security User Guide.

Variable Definition

partition name is the name assigned to the partition

userid is a valid MDMWeb user ID

password is a valid password for the MDMWeb user ID.

partition name is the name assigned when you create the 
partition. If you omit the partition name and the 
entry line contains only the user ID and 
password, no partition is assigned to that user 
ID. The user, therefore, can view the entire 
network 
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Variable definitions

Changing the MDMWeb password
Change the MDMWeb password to ensure network security.

Procedure steps
1 Using an editor such as vi, open the file /opt/MagellanNMS/cfg/private/

MDMWebUsers.cfg.

2 Locate the userID that owns the password that you want to change.

3 On the line that contains the userID, type the new password between the 
first and second colon (:). 

4 Save and close the file.

Variable definitions

Starting the MDMWeb server agents
After you complete the MDMWeb server software installation, start the 
MDMWeb server agents. You need an account that is set up to use the Preside 
Multiservice Data Manager (MDM) Server Administration tool (SVMADM) 
to start the following:

• Passport shelf view agent (psvagent) 
Although psvagent behaves as an agent in MDMWeb, it is actually a 
fulltime server and is installed and started through the installation of base 
MDM software. If the server has been stopped and you need to start it, 
see the Passport Shelf View Server Agent (PSVAGENT) section in 
241-6001-310 Preside MDM Server Reference Guide.

Variable Definition

userid is the name of the user ID

password is the password associated with the user ID

Variable Definition

userid is the name of the user ID

password is the password associated with the user ID
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• general management data router agent (gmdragent)

• network model agent (nmagent)

• real time alarm collection (rtacagent)

• multi-nodal name server agent (mnsdagent)

Displaying online server agent information
This optional procedure lets you display online help information for the 
server agent command line.

1 Change paths to /opt/MagellanNMS/bin.

2 Type the following:

<agent name> -h

Variable definitions

Starting the MDMWeb gmdragent
1 From the Server Administration Security menu, select Enable Editing.

The SVM Enter Edit Password dialog opens and prompts for a 
password.

2 If required, type a valid password and click OK.

The Server Administration dialog to edit servers opens.

3 From the Edit menu, select New.

4 In the Descriptive name field, type the following information:

MDMWeb GMDR Agent

5 In the Startup command field, type one of the following commands:

/opt/MagellanNMS/bin/gmdragent

/opt/MagellanNMS/bin/gmdragent -l

Variable Definition

agent name is one of psvagent, gmdragent, or nmagent

-h is a command option to display online help 
information
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Note:  The -l option turns logging on. The log file can be found in the 
directory /opt/MagellanNMS/data/log/MDMAgents.

6 Enable the Automatic startup at reboot time option.

7 Click Save and Start.

The data you entered is stored and the server is started.

8 From the File menu, select Refresh server list.

An updated server list is displayed, including the gmdragent.

Starting the MDMWeb nmagent
1 From the Server Administration Security menu, select Enable Editing.

The SVM Enter Edit Password dialog opens and prompts for a 
password.

2 If required, type a valid password and click OK.

The Server Administration dialog to edit servers opens.

3 From the Edit menu, select New.

4 In the Descriptive name field, type the following information:

MDMWeb NM Agent

5 In the Startup command field, type one of the following commands:

/opt/MagellanNMS/bin/nmagent

/opt/MagellanNMS/bin/nmagent -l

Note:  The -l option turns logging on. The log file can be found in the 
directory /opt/MagellanNMS/data/log/MDMAgents.

6 Enable the Automatic startup at reboot time option.

7 Click Save and Start.

The data you entered is stored and the server is started.

8 From the File menu, select Refresh server list.

An updated server list is displayed, including the nmagent.

The MDMWeb server installation is now complete. Next, install the 
MDMWeb client. For details, refer to the installation instructions that are 
specific to your client platform:

• “Installing the MDMWeb client on Solaris” (page 37)
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• “Installing the MDMWeb client on Windows” (page 53)

Starting the MDMWeb rtacagent
1 Ensure the real time alarm collection tool (rtaccol) is running. If rtaccol is 

not running there will be no rtac data for the agent to send. For more 
information on rtaccol, see i241-6001-310 Preside MDM Server 
Reference Guide.

2 From the Server Administration Security menu, select Enable Editing.

The SVM Enter Edit Password dialog opens and prompts for a 
password.

3 If required, type a valid password and click OK.

The Server Administration dialog to edit servers opens.

4 From the Edit menu, select New.

5 In the Descriptive name field, type the following information:

MDMWeb RTAC Agent

6 In the Startup command field, type the following information:

/opt/MagellanNMS/bin/rtacagent

7 Enable the Automatic startup at reboot time option.

8 Click Save and Start.

The data you entered is stored and the server is started.

9 From the File menu, choose Refresh server list.

An updated server list is displayed, including the rtacagent.

Starting the MDMWeb mnsdagent
1 From the Server Administration Security menu, select Enable Editing.

The SVM Enter Edit Password dialog opens and prompts for a 
password.

2 If required, type a valid password and click OK.

The Server Administration dialog to edit servers opens.

3 From the Edit menu, select New.

4 In the Descriptive name field, type the following information:

MDMWeb MNSD Agent
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5 In the Startup command field, type the following command:

/opt/MagellanNMS/bin/mnsdagent

6 Enable the Automatic startup at reboot time option.

7 Click Save and Start.

The data you entered is stored and the server is started.

8 From the File menu, choose Refresh server list.

An updated server list is displayed, including the rtacagent.

Server port numbers
MDMWeb agents can connect to any available port instead of being fixed to 
a specific port. A new agent, multi-nodal name server (mnsdagent) is the only 
agent with a fixed port. When an MDMWeb client makes a connection to an 
agent, the client contacts mnsdagent to look up the agent’s current port. The 
mnsdagent communicates with the mnsd server, which stores the port 
communication.

You can customize the mnsdagent port (such as for firewalls) using the -p 
startup option. For example, mnsdagent -p 5432 starts the mnsdagent on port 
5432. If the option -p <port value> is not specified, the default port is 5934. 
If the mnsdagent on the MDM server is started with a customized port 
number, the port number in the resources file on the MDMWeb client 
machine must be matched. See “Configuring the resource file to specify the 
mnsdagent port” (page 43).

Changing Apache port numbers
1 While logged on as root, change paths to the Apache directory:

cd /opt/MagellanContrib/apache/conf

2 Using an editor such as vi, open the file httpd.conf.

3 Replace the port value of 8080 with a new port value.

4 Save the changes and close the file httpd.conf.

5 Change paths to /etc/init.d/.

6 Execute the Apache control script to establish a command line interface 
connection to Apache:
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apachectl<ApacheVersion> stop
apachectl<ApacheVersion> start

7 Change the Context Server configuration of the port variable to new port 
value by logging in to the MDM server and completing the following steps:

a. Source the MDM environment file:

csh
source /opt/MagellanNMS/bin/nmsch

b. Check the current configuration of the port variable:

ctxcmd -s WEBUNIHELPHOST

Notice the return value of the port. For example, “value is: 
47.135.225.32:8080”.

c. Change the port number:

ctxcmd -pw WEBUNIHELPHOST <serverIP:portnumber>

The port number is successfully changed when you see the 
message, “successful context operation.”

d. Check the port number changed:

ctxcmd -s WEBUNIHELPHOST

Verify that the port value returned from the ctxcmd -s command 
shows the new port value.

Variable definitions

Variable Definition

ApacheVersion is the Apache software version, without the 
decimals, provided on the CD-ROM. For 
example, if the Apache version is 1.3.9, use the 
value 139 for the Apache version variable. The 
control script is then apachect1139 start.

serverIP:portnumber serverIP is the IP address of the context server; 
portnumber is the new port value.
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Installing the MDMWeb client on Solaris

This section provides procedures for installing and configuring the MDMWeb 
client software on a Solaris platform and contains the following topics:

• “Solaris client application installation procedures” (page 37)

• “Removing the MDMWeb Solaris client application” (page 51)

Solaris client application installation procedures
To install the Solaris client application, perform the following procedures:

1 “Preparing to install MDMWeb Solaris client” (page 38)

2 “Installing Solaris patches for use with JRE” (page 38)

3 “Installing JRE for Solaris” (page 38)

4 “Installing MDMWeb Solaris client application” (page 40)

5 “Configuring the resource file for MDMWeb Solaris client” (page 41)

6 “Configuring the resource file for sound” (page 42) (if required)

7 “Configuring the resource file to specify the mnsdagent port” (page 43)

8 “Configuring the resource file to use a custom menu” (page 46)

9 “Configuring the resource file to edit CIV commands” (page 47)

10 “Adding the server host name to the /etc/hosts file” (page 49)
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Preparing to install MDMWeb Solaris client
Before you install the MDMWeb client software, ensure that the MDMWeb 
server software has been installed. For details, see “Installing the MDMWeb 
server” (page 27)

Installing Solaris patches for use with JRE
You need to install Solaris patches before installing the Java Runtime 
Environment (JRE). You can obtain these patches from the following 
locations:

• MDM CD-ROM 

• Sun Solaris web site

MDM CD-ROM
The MDM CD-ROM contains the Solaris patches for JRE in the directory 
Aux/5.7 or Aux/5.8. This file is a tar file of tar files. When you untar the file, 
you create various patch directories. Each patch directory includes a specific 
patch and README file that contains patch installation instructions. Read all 
README files before proceeding with the patch installation. 

Sun Solaris web site
You can download Solaris patches for JRE from the Solaris web site at URL 
http://www.sun.com/Solaris/jre. This site contains the most recent patches.

Some patch installations can fail. If so, it is possible that your workstation 
already has the patches installed. Check the output from the install script for 
messages.

Installing JRE for Solaris
The JRE plug-in is included with the JRE software. When you install the 
MagJ<release> package, both the JRE software and the JRE plug-in are 
installed.

1 Log on as root.

2 Insert the MDM CD-ROM into the Solaris client desktop CD-ROM disk 
drive, pattern side up. 

3 Open a UNIX window using the CDE window manager.
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4 Start the Sun admintool by typing the following command in the UNIX 
window:

/usr/bin/admintool &

The Admintool: Users window opens.

5 On the Browse menu, click Software.

The Admintool: Software window opens and lists all software installed 
on the workstation.

6 From the Edit menu, click Add.

The Admintool: Set Source Media dialog opens.

7 From the Software Location list box, select CD with Volume 
Management.

8 Type the correct path name of the source media:

/cdrom/cdrom0

9 Click OK.

The Admintool: Add Software dialog opens and lists the software on the 
CD-ROM.

10 From the list of software, select the version of Sun Java Runtime 
Environment provided on the CD-ROM, for example Sun Java Runtime 
Environment 1.4.0.

11 Click Add.

12 Verify that the JRE software for Solaris installation is successful. Check 
for the existence of the JRE directories:

cd /opt/MagellanContrib/JRE/
Solaris_JRE_<VersionNumber>
ls -l 

Variable definitions

Variable Definition

VersionNumber is the version number of the JRE software 
provided on the CD-ROM. For example, if you 
use JRE version 1.4.0, the directory name is 
Solaris_JRE_1.4.0 and the full pathname is /opt/
MagellanContrib/JRE/Solaris_JRE_1.4.0.
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Installing MDMWeb Solaris client application
1 With the MDM CD-ROM in the CD-ROM drive, type the following 

command in a UNIX window:

cd /cdrom/cdrom0

2 Run the InstallAnywhere program. This program guides you through the 
installation process with a series of prompts. Start the program by 
entering the following command:

NMSWeb_Install_Solaris.bin

When all prompts have been answered and the InstallAnywhere program 
is finished, the Install Complete window displays.

a. The Choose Install Folder window prompts you to identify the 
location for the files about to be installed. It is recommended that you 
install the files in the directory /opt/Nortel. 

It is recommended that users who will be using the client install it in 
their local directory under their own userID. If this package is being 
installed by root, change the permissions on the files webnmsc and 
webnmsi to make them executable by all users.

If you are going to use the invisible desktop, you need to execute the 
script sendwebcmd. The script is packaged with the Solaris client 
application, and it is automatically installed. 

b. The Choose Link Location window prompts you about whether or 
not you want to create links. If you choose to create links to the 
MDMWeb executable programs, the link location can be in your home 
directory or another directory in the file system. 

c. The Choose Java Virtual Machine window prompts you to identify 
a Java Virtual Machine. From the list of virtual machines already 

CAUTION
Maintain resource file backup if you already have the 
MDMWeb client package installed. The backup file is 
only for reference. The resource file may change with a 
new release.
Before you run the installAnywhere program, ensure that 
you have a backup copy of the most recent version of the 
MDMWeb resource file <install path>/MDMWeb/cfg/
WebNmsRes.txt. The installAnywhere program will delete 
the existing resource file.
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installed, select the Java Virtual Machine under the directory
/opt/MagellanContrib/JRE/current/bin. 

d. If it is not listed under the selection window, click the mouse on the 
Choose another action button. In the dialog that opens, do the 
following:

In the Enter path or folder name text box, type /opt/
MagellanContrib/JRE/current/bin.

Then in the Enter file name text box, type java.

e. Click OK.

3 To exit InstallAnywhere, click Done.

Note:  The InstallAnywhere program also lets you remove, or uninstall, 
the MDMWeb client application.

4 If you installed the script sendwebcmd, check the file permissions to 
ensure that it is accessible by all users.

Configuring the resource file for MDMWeb Solaris client
To configure the MDMWeb Solaris client, edit the resource file, making the 
appropriate changes in the SYSTEM block.

1 While logged on as root, open the resource file
<install path>/MDMWeb/cfg/WebNmsRes.txt

2 Set the SERVERHOST parameter. Specify the MDMWeb server host 
name or the MDMWeb server host IP address:

SERVERHOST = <host name>|<“ip address”>

3 Save the changes and close the file.

CAUTION
Maintain resource file backup 
Before you change the resource file, ensure that you have a 
backup copy of the most recent version. An error in the 
resource file can cause problems for the client. 
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Variable definitions

Configuring the resource file for sound
The alarm display application provides an option to play a sound when alarms 
arrive in the alarm display. This lets you associate a particular sound with a 
particular alarm severity. For example, a beep occurs each time the alarm 
display receives a critical alarm. 

If your hardware supports sound and you want to use the sound option, make 
the following changes to the resource file.

1 While logged on as root, open the resource file
<install path>\MDMWeb\cfg\WebNmsRes.txt

2 For every sound resource you want to use, add the following commands:

SOUND <soundname> 
BEGIN

SOUNDURL = file:/C:\\WINNT\Media\\notify.wav
END

3 Add the following commands to define sounds for each alarm severity:

SOUNDSCHEME
BEGIN

CRITICALSOUND = <critical soundname>

Variable Definition

install path is the path to the MDMWeb file system identified 
during the MDMWeb client installation. For 
example, /opt/Nortel/MDMWeb/cfg/
WebNmsRes.txt.

 host name is the name of the MDMWeb server host

“ip address” is the IP address of the MDMWeb server host

CAUTION
Maintain resource file backup 
Before you change the resource file, ensure that you have a 
backup copy of the most recent version. An error in the 
resource file can cause problems for the client. 
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MAJORSOUND = <major soundname>
MINORSOUND = <minor soundname>
WARNINGSOUND = <warning soundname>

END

Variable definitions

If your system does not have sound resources defined, you can use the default 
system beep. For example, to play a beep sound when a critical alarm occurs, 
use the variable SYSTEMBEEP in the sound definition command:

CRITICALSOUND = SYSTEMBEEP

Configuring the resource file to specify the mnsdagent port
MDMWeb agents can connect to any available ports instead of to one specific 
port. The mnsdagent is the only agent with a fixed port. When an MDMWeb 
client makes a connection to an agent, the client contacts the mnsdagent to 
look up the agent’s current port. The resource file maintains a list of service 
names, which are the names the mnsdagent uses to look up port numbers. 

You can modify the resource file to specify the port the mnsdagent uses. If you 
do not specify the port, you must specify the servicename.

Variable Definition

install path is the path to the MDMWeb file system identified 
during the MDMWeb client installation. For 
example, /opt/Nortel/MDMWeb/cfg/
WebNmsRes.txt.

 soundname is the name of the sound resource

soundurl is the location of the sound resource file

critical soundname is the name of the critical sound resource

major soundname is the name of the major sound resource

minor soundname is the name of the minor sound resource

warning soundname is the name of the warning sound resource
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1 While logged on as root, open the resource file
<install path>/MDMWeb/cfg/WebNmsRes.txt

2 In the service block of the resource file, specify the port number that the 
mnsdagent will listen on.

SERVER MNSDAGENT
BEGIN

PORT = <port number>

END

Note:  If you do not specify the port number, you must specify the 
servicename. In the example, the MDMWeb client uses mnsdagent to 
look up the specific port associated with gmdragent.

Example:

SERVER GMDRAGENT
BEGIN

SERVICENAME = “gmdragent”

END

3 Save the changes and close the file.

Variable definitions

CAUTION
Maintain resource file backup 
Before you change the resource file, ensure that you have a 
backup copy of the most recent version. An error in the 
resource file can cause problems for the client. 

Variable Definition

install path is the path to the MDMWeb file system identified 
during the MDMWeb client installation. For 
example, /opt/Nortel/MDMWeb/cfg/
WebNmsRes.txt.

 port number is the port number the mnsdagent listens on
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Configuring the resource file to obtain alarms from RTAC
The alarm display application gathers its alarm history information from a 
general management data router (GMDR) server. The GMDR server has 
limited storage for alarm history. 

You can configure the resource file to obtain alarm history information from 
the real time alarm collection (RTAC) tool. You do this by changing the 
RTACHISTORY tag in the alarm display block of the resource file. Alarm 
history information will be delivered to MDMWeb by the rtacagent server.

1 While logged on as root, open the resource file
<install path>/MDMWeb/cfg/WebNmsRes.txt

2 Change the RTACHISTORY tag to true in the alarm display block of the 
resource file.

APP ALARMBROWSER
BEGIN

/* Alarm browser fields */
RTACHISTORY = TRUE

END

Note:  If the RTACHISTORY tag is set to false, the alarm history will be 
gathered by GMDR.

3 Save the changes and close the file.

Variable definitions

CAUTION
Maintain resource file backup 
Before you change the resource file, ensure that you have a 
backup copy of the most recent version. An error in the 
resource file can cause problems for the client. 

Variable Definition

install path is the path to the MDMWeb file system identified 
during the MDMWeb client installation. For 
example, /opt/Nortel/MDMWeb/cfg/
WebNmsRes.txt.
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Configuring the resource file to use a custom menu
You can integrate your own tools within MDMWeb by using a custom menu. 
These tools can then be launched from within MDMWeb’s launch pad. 

You define the commands that appear in the custom menu by specifying the 
MENUNAME and COMMAND fields in the EXTERNALCOMMAND 
block in the resource file.

The MENUNAME specifies the string that appears for the command in the 
custom menu. The COMMAND field specifies the string that executes the 
command.

1 While logged on as root, open the resource file
<install path>/MDMWeb/cfg/WebNmsRes.txt

2 In the EXTERNALCOMMAND block of the resource file, specify a custom 
menu.

EXTERNALCOMMAND <command name>
BEGIN
MENUNAME = <“menu_display_string”>
COMMAND = <“command_to_execute”>

END

The example sets up a custom menu command which creates a telnet 
session to the host, hostx.

Example:

EXTERNALCOMMAND TelnetHostX
BEGIN
MENUNAME = “Telnet to hostx”
COMMAND = “telnet hostx”

END

CAUTION
Maintain resource file backup 
Before you change the resource file, ensure that you have a 
backup copy of the most recent version. An error in the 
resource file can cause problems for the client. 
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3 Save the changes and close the file.

Variable definitions

Configuring the resource file to edit CIV commands
The Command menu of the component information viewer (CIV) contains 
diagnostic commands that you can use to diagnose network problems. These 
commands are displayed by default. For a listing of the CIV default 
commands, see 241-6001-011 Preside MDM Fault Management User Guide.

In some cases, you may wish to add your own commands to the Command 
menu. You can do this by configuring the DIAGNOSTIC_COMMAND block 
in the resource file.

The DIAGNOSTIC_COMMAND block contains three fields that you need to 
edit:

• The DISPLAY field is the string that appears on the menu for the 
command.

• The COMMAND field is the actual command which is executed on the 
device.

• The DEVICE field is determines which devices this command is applies 
to. This field may also contain parts of the subcomponent hierarchy if the 
command is only valid for specific subcomponents. 

Variable Definition

install path is the path to the MDMWeb file system 
identified during the MDMWeb client 
installation. For example, /opt/Nortel/
MDMWeb/cfg/WebNmsRes.txt.

 menu_display_string is the name that appears in the Custom menu

command_to_execute is the executable command
Preside MDM MDMWeb Installation Guide   14.3RSUP



48   Chapter 3 Installing the MDMWeb client on Solaris
1 While logged on as root, open the resource file
<install path>/MDMWeb/cfg/WebNmsRes.txt

2 In the DIAGNOSTIC_COMMAND block, create the commands you wish 
to display in the Command menu.

DIAGNOSTIC_COMMAND <command name>
BEGIN
DISPLAY = <“display_name”>
COMMAND = <“command_to_execute”>
DEVICE = <device>

END

Note:  For multiple devices, separate each by the | symbol.

In the example, the Display Software command for Passport devices is 
created.

Example:

DIAGNOSTICCOMMAND DisplaySoftwareCommand
BEGIN
DISPLAY = “Display Software”
COMMAND = “display -p sw”
DEVICE = EM

END

3 To display the command name in the Command menu, modify the 
DIAGNOSTIC_COMMAND_MENU list. Enter the command display 
names that you created in step 2.

LIST DIAGNOSTIC_COMMAND_MENU
BEGIN
<command>
<command>

CAUTION
Maintain resource file backup 
Before you change the resource file, ensure that you have a 
backup copy of the most recent version. An error in the 
resource file can cause problems for the client. 
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<command>

END

4 Save the changes and close the file.

Variable definitions

Adding the server host name to the /etc/hosts file
1 While logged on as root, display the contents of the file /etc/hosts:

more /etc/hosts

2 Check that the file /etc/hosts contains an entry for the IP address and host 
name of the Solaris MDMWeb client. If the entry is missing, add the entry 
using an editor such as vi.

<ip address> <host name>

Variable definitions

Variable Definition

display_name is the command name that is displayed in the 
Command menu

 command_to_execute is the executable command. For example, 
display -p sw

device is the device the command applies to. For 
example, EM.

commands is the name of the command that will display in 
the Command menu. You can add as many 
commands as you wish.

Variable Definition

ip address is the IP address of the Solaris MDMWeb server

 host name is the name of the Solaris MDMWeb server
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Specifying the installed Netscape path
MDMWeb uses Netscape to view online documentation. You must set the 
environment variable path to include the Netscape installed directory for the 
help to work. If multiple users are using the system, you must set the 
environment variables in each user’s environment in one of the following 
locations:

• at the command line

• in a .cshrc file

• in a .profile file

1 Perform one of the following procedures substeps:

a. If you are using C shell (csh), enter the following command to append 
the path to the existing PATH variable:

% set path = ($path <full_Netscape_installed_path>)

b. If you are using Bourne shell (sh) or Korn shell (ksh), enter the 
following commands:

% PATH=<full_Netscape_installed_path>:$PATH
% export PATH

Variable definitions

Variable Definition

full_Netscape_installed_path is the full pathname for the 
installed Netscape
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Removing the MDMWeb Solaris client application
If you need to, you can remove (or uninstall) the MDMWeb client application.

1 Start the uninstall program by entering the following command:

<install path>/MDMWeb/UninstallerData/
Uninstall_MDMWebSolaris

2 Answer all prompts. 

3 When the uninstall program completes, click Exit.

Variable definitions

CAUTION
Maintain resource file backup if you already have the 
MDMWeb client package installed. The backup file is 
only for reference. The resource file may change with a 
new release.
Before you run the uninstall program, ensure that you have 
a backup copy of the most recent version of the MDMWeb 
resource file <install path>/MDMWeb/cfg/
WebNmsRes.txt. The uninstall program will delete the 
existing resource file. 

Variable Definition

install path is the path to the MDMWeb file system identified 
during the MDMWeb client installation. For 
example, /opt/Nortel/MDMWeb/cfg/
WebNmsRes.txt.
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Installing the MDMWeb client on Windows

This section provides detailed procedures for installing and configuring the 
MDMWeb client software on Windows platforms and contains the following 
topics:

• “Windows client application installation procedures” (page 53)

• “Removing the MDMWeb Windows client application” (page 62)

Windows client application installation procedures
To install the Windows client, perform the following procedures:

1 “Preparing to install MDMWeb client application software” (page 53)

2 “Installing JRE for Windows” (page 54)

3 “Installing the MDMWeb Windows client application” (page 54)

4 “Configuring the resource file for MDMWeb Windows client” (page 55)

5 “Configuring the resource file for sound” (page 56) (if needed)

6 “Configuring the resource file to obtain alarms from RTAC” (page 57)

7 “Configuring the resource file to use a custom menu” (page 58)

8 “Configuring the resource file to edit CIV commands” (page 60)

Preparing to install MDMWeb client application software
1 Before you install the MDMWeb client application software, ensure that 

the MDMWeb server software is installed. For details, see “Installing the 
MDMWeb server” (page 27).
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Installing JRE for Windows
The JRE plug-in is included with the JRE software. When you install the 
MagJ<release> package, both the JRE software and the JRE plug-in are 
installed.

1 Insert the MDM CD-ROM into the CD-ROM drive, pattern side up.

2 Display the list of files on the MDM CD-ROM using Windows Explorer and 
locate the JRE win.exe file. The file name has the following format:

jre<Version>-win.exe

3 Copy the JRE win.exe file onto the hard disk by double-clicking its file 
icon.

The JRE win.exe file installs on the hard drive with the path C:\Program 
Files\JavaSoft\Jre.

Variable definitions

Installing the MDMWeb Windows client application
1 Start Windows Explorer.

2 Click the icon that represents the CD-ROM drive.

The contents of the MDM CD-ROM display on the right.

Variable Definition

Version is the JRE software version provided on the CD-
ROM. For example, if the JRE version is 
1.4.0_01, then the file name is j2re-1_4_0_01-
windows-i586.exe
241-6001-117   14.3RSUP   



Chapter 4 Installing the MDMWeb client on Windows   55
3 Start the InstallAnywhere script. This program guides you through the 
installation process with a series of prompts. To start this program, 
double-click the MDMWeb_Install_Windows.exe icon. 

When all prompts have been answered and the InstallAnywhere program 
is finished, the Install Complete window displays.

a. The Choose Install Folder window prompts you to identify the 
location for the files about to be installed. It is recommended that you 
install the files in the directory \C:\Program Files\. 

4 To exit InstallAnywhere, click Done.

Configuring the resource file for MDMWeb Windows client
Configure the MDMWeb server host name information in the resource file, 
making the appropriate changes in the SYSTEM block.

1 Open the file C:\<install path>\MDMWeb\cfg\WMSWinRes.txt

Example:

<install path>\MDMWeb\cfg\WMSWinRes.txt.

CAUTION
Maintain resource file backup if you already have the 
MDMWeb client package installed. The backup file is 
only for reference. The resource file may change with a 
new release.
Before you run the installAnywhere program, ensure that 
you have a backup copy of the most recent version of the 
MDMWeb resource file <install path>/MDMWeb/cfg/
WMSWinRes.txt. The installAnywhere program will 
delete the existing resource file. 

CAUTION
Maintain resource file backup 
Before you change the resource file, ensure that you have a 
backup copy of the most recent version. An error in the 
resource file can cause problems for the client.
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2 Set the SERVERHOST parameter to the MDMWeb server host name; or, 
set the SERVERHOST parameter to the MDMWeb server host IP 
address:

SERVERHOST = <host name>|<“ip address”>

3 Save the changes and close the file.

Variable definitions

Configuring the resource file for sound
The alarm display application provides an option to play a sound when alarms 
arrive in the alarm display. This lets you associate a particular sound with a 
particular alarm severity. For example, a beep occurs each time the alarm 
display receives a critical alarm. 

If your hardware supports sound and you want to use the sound option, make 
the following changes to the resource file.

1 While logged on as root, open the resource file 
<install path>\MDMWeb\cfg\WMSWinRes.txt.

2 For every sound resource you want to use, add the following commands:

SOUND <soundname> 
BEGIN

SOUNDURL = file:/C:\\WINNT\\Media\\notify.wav
END

Variable Definition

install path is the path to the MDMWeb file system identified 
during the MDMWeb client installation

host name is the name of the MDMWeb server host

ip address is the IP address of the MDMWeb server host

CAUTION
Maintain resource file backup 
Before you change the resource file, ensure that you have a 
backup copy of the most recent version. An error in the 
resource file can cause problems for the client. 
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3 Add the following commands to define sounds for each alarm severity:

SOUNDSCHEME
BEGIN

CRITICALSOUND = <critical soundname>
MAJORSOUND = <major soundname>
MINORSOUND = <minor soundname>
WARNINGSOUND = <warning soundname>

END

Variable definitions

If your system does not have sound resources defined, you can use the default 
system beep. For example, to play a beep sound when a critical alarm occurs, 
use the variable SYSTEMBEEP in the sound definition command:

CRITICALSOUND = SYSTEMBEEP

Configuring the resource file to obtain alarms from RTAC
The alarm display application gathers its alarm history information from a 
general management data router (GMDR) server. The GMDR server has 
limited storage for alarm history. 

You can configure the resource file to obtain alarm history information from 
the real time alarm collection (RTAC) tool. You do this by changing the 
RTACHISTORY tag in the alarm display block of the resource file. Alarm 
history information will be delivered to MDMWeb by the rtacagent server.

Variable Definition

install path is the path to the MDMWeb file system identified 
during the MDMWeb client installation. For 
example, /opt/Nortel/MDMWeb/cfg/
WMSWinRes.txt.

 soundname is the name of the sound resource

soundurl is the location of the sound resource file

critical soundname is the name of the critical sound resource

major soundname is the name of the major sound resource

minor soundname is the name of the minor sound resource

warning soundname is the name of the warning sound resource
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1 While logged on as root, open the resource file
<install path>\MDMWeb\cfg\WebNmsRes.txt

2 Change the RTACHISTORY tag to true in the alarm display block of the 
resource file.

APP ALARMBROWSER
BEGIN

/* Alarm browser fields */
RTACHISTORY = TRUE

END

Note:  If the RTACHISTORY tag is set to false, the alarm history will be 
gathered by GMDR.

3 Save the changes and close the file.

Variable definitions

Configuring the resource file to use a custom menu
You can integrate your own tools within MDMWeb by using a custom menu. 
These tools can then be launched from within MDMWeb’s launch pad. 

You define the commands that appear in the custom menu by specifying the 
MENUNAME and COMMAND fields in the EXTERNALCOMMAND 
block in the resource file.

CAUTION
Maintain resource file backup 
Before you change the resource file, ensure that you have a 
backup copy of the most recent version. An error in the 
resource file can cause problems for the client. 

Variable Definition

install path is the path to the MDMWeb file system identified 
during the MDMWeb client installation. For 
example, /opt/Nortel/MDMWeb/cfg/
WMSWinRes.txt.
241-6001-117   14.3RSUP   



Chapter 4 Installing the MDMWeb client on Windows   59
The MENUNAME specifies the string that appears for the command in the 
custom menu. The COMMAND field specifies the string that executes the 
command.

1 While logged on as root, open the resource file 
<install path> \MDMWeb\cfg\WMSWinRes.txt.

2 In the EXTERNALCOMMAND block of the resource file, specify a custom 
menu.

EXTERNALCOMMAND <command name>
BEGIN
MENUNAME = <“menu_display_string”>
COMMAND = <“command_to_execute”>

END

The example sets up a custom menu command which creates a telnet 
session to the host, hostx.

Example:

EXTERNALCOMMAND TelnetHostX
BEGIN
MENUNAME = “Telnet to hostx”
COMMAND = “telnet hostx”

END

3 Save the changes and close the file.

CAUTION
Maintain resource file backup 
Before you change the resource file, ensure that you have a 
backup copy of the most recent version. An error in the 
resource file can cause problems for the client. 
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Variable definitions

Configuring the resource file to edit CIV commands
The Command menu of the component information viewer (CIV) contains 
diagnostic commands that you can use to diagnose network problems. These 
commands are displayed by default. For a listing of the CIV default 
commands, see 241-6001-011 Preside MDM Fault Management User Guide.

In some cases, you may wish to add your own commands to the Command 
menu. You can do this by configuring the DIAGNOSTIC_COMMAND block 
in the resource file.

The DIAGNOSTIC_COMMAND block contains three fields that you need to 
edit:

• The DISPLAY field is the string that appears on the menu for the 
command.

• The COMMAND field is the actual command which is executed on the 
device.

• The DEVICE field is determines which devices this command is applies 
to. This field may also contain parts of the subcomponent hierarchy if the 
command is only valid for specific subcomponents. 

Variable Definition

install path is the path to the MDMWeb file system 
identified during the MDMWeb client 
installation. For example, /opt/Nortel/
MDMWeb/cfg/WMSWinRes.txt.

 menu_display_string is the name that appears in the Custom menu

command_to_execute is the executable command

CAUTION
Maintain resource file backup 
Before you change the resource file, ensure that you have a 
backup copy of the most recent version. An error in the 
resource file can cause problems for the client. 
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1 While logged on as root, open the resource file 
<install path>\MDMWeb\cfg\WMSWinRes.txt.

2 In the DIAGNOSTIC_COMMAND block, create the commands you wish 
to display in the Command menu.

DIAGNOSTIC_COMMAND <command name>
BEGIN
DISPLAY = <“display_name”>
COMMAND = <“command_to_execute”>
DEVICE = <device>

END

Note:  For multiple devices, separate each by the | symbol.

In the example, the Display Software command for Passport devices is 
created.

Example:

EXTERNALCOMMAND DisplaySoftwareCommand
BEGIN
DISPLAY = “Display Software”
COMMAND = “display -p sw”
DEVICE = EM

END

3 To display the command name in the Command menu, modify the 
DIAGNOSTIC_COMMAND_MENU list. Enter the command display 
names that you created in step 2.

LIST DIAGNOSTIC_COMMAND_MENU
BEGIN
<command>
<command>
<command>

END

4 Save the changes and close the file.
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Variable definitions

Removing the MDMWeb Windows client application
If you need, you can remove (or uninstall) the MDMWeb client application.

1 Start the uninstall program by entering the following command:

<install path>\MDMWeb\UninstallerData\
Uninstall MDMWebWindows.exe

Example:

C:\Program Files\MDMWeb\UnistallerData\Uninstall 
MDMWeb.exe

The uninstall program starts and displays the uninstall window.

Variable Definition

display_name is the command name that is displayed in the 
Command menu

 command_to_execute is the executable command. For example, 
display -p sw

device is the device the command applies to. For 
example, EM.

commands is the name of the command that will display in 
the Command menu. You can add as many 
commands as you wish.

CAUTION
Maintain resource file backup if you already have the 
MDMWeb client package installed. The backup file is 
only for reference. The resource file may change with a 
new release.
Before you run the uninstall program, ensure that you have 
a backup copy of the most recent version of the MDMWeb 
resource file <install path>/MDMWeb/cfg/
WMSWinRes.txt. The uninstall program will delete the 
existing resource file. 
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2 Answer all prompts. 

3 When the uninstall program completes, click Exit.

Variable definitions

Variable Definition

install path is the path to the MDMWeb file system identified 
during the MDMWeb client installation. For 
example, /opt/Nortel/MDMWeb/cfg/
WMSWinRes.txt.
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Appendix A
Engineering Information 

This section provides engineering information for MDMWeb and contains 
the following topics: 

• “Resource requirements” (page 65)

• “Communication requirements” (page 66)

• “MDMWeb performance” (page 66)

Resource requirements
Resource requirements are as follows:

• MDMWeb server supports a maximum of 10 clients.

• MDMWeb server minimum requirements are as follows:

— a Sun Ultra 10 Workstation

— 128 Mbyte RAM

— 2 Gbyte hard disk

• MDMWeb client minimum requirements are as follows:

— for Solaris, Sun Ultra 1 or Ultra 10 workstation with 256 Mbyte 
RAM

— for Windows 2000, 128 Mbyte RAM

— for Windows NT, 128 Mbyte RAM 

— for Windows XP, 128 Mbyte RAM
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Communication requirements
The communication requirements are as follows:

• TCP/IP based socket communication between MDMWeb server and 
MDMWeb client

• TCP/IP based IPI protocol between MDMWeb server and MDM server

MDMWeb performance
MDMWeb clients are expected to have similar performance to current Xterm-
based clients from the MDM server workstation.
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